Ingenieria Técnica de Sistemas Electronicos.
Escuela Técnica Superior de Ingenieria Industrial y de Telecomunicacion.
Laboratorio de Electronica Digital.

Practica n° 4. Tarjeta de diseinio en CPLDs.

El objetivo de esta practica es aprender las caracteristicas basicas de una tarjeta para el disefio
de circuitos digitales sobre dispositivos 16gicos programables, y familiarizarse con los pasos
basicos del proceso de disefio y programacion del dispositivo logico. La tarjeta que se
utilizard en las practicas es la tarjeta ALTERA DE2 que lleva insertado el dispositivo
programable Cyclone II EP2C35F672C6N de ALTERA. La programacion del dispositivo se
realizard desde un ordenador personal, conectado a la tarjeta a través de un puerto USB,
mediante la herramienta de disefio Quartus II de ALTERA. Para el disefio y simulacion de los
circuitos se utilizard Quartus II, preferentemente mediante el lenguaje VHDL aunque podria
hacerse también mediante un diagrama esquematico.

El paquete ALTERA DE2 incluye, ademds de la tarjeta, un cable USB de conexion al
ordenador, el conector a la fuente de alimentacion, un CD con el programa Quartus II
(version 6.0), un CD con la descripcion del microprocesador Nios I que se puede cargar en el
dispositivo programable y un CD DE2 con manuales, hojas de caracteristicas, esquemas,
ejercicios guiados (de la tarjeta DE2 y de Quartus II), practicas propuestas, demostraciones
avanzadas, etc. Mas informacion sobre la tarjeta DE2 se puede encontrar en la pagina Web de
ALTERA:

http://university.altera.com/materials/boards/unv-de2-board.html

Las caracteristicas basicas de la tarjeta DE2 se muestran en el fichero DE2 introduction _box
(disponible en el CD DE2 y en la pagina WEB de la asignatura). Una descripcion mas
detallada de la tarjeta y de sus componentes se muestra en el fichero DE2 UserManual
(disponible en el CD DE2, directorio DE2 user manual, y en la pagina WEB de la
asignatura).

La tarjeta dispone de un dispositivo Cyclone I EP2C35F672C6N (la hoja de caracteristicas
de este dispositivo y de los demas dispositivos de la tarjeta se encuentran en el CD DE2 en el
directorio Datasheets->Cyclone II), que tiene 475 pines disponibles (empaquetamiento de
672), contiene 33216 LEs (elementos logicos complejos, ver pagina 2-3 de la hoja de
caracteristicas), 483840 bits de RAM (105 bloques de 4Kbits), 35 multiplicadores 18*18 y 4
PLLs (para generacion de sefiales de reloj).

Dentro de la tarjeta se disponen de una serie de componentes conectados a unos pines

determinados del dispositivo programables (ver DE2 UserManual). En estas practicas se
usaran principalmente los entradas y salidas digitales entre las que se encuentran:
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LE de Cyclone II

- 4 botones KEY0-KEY3 de entrada (normalmente altos, al pulsar generan un pulso a bajo).
Estos botones tienen circuitos que eliminan rebotes u oscilaciones en la tension.

- 18 conectores digitales SW0-SW17 de entrada (abajo 0, arriba 1). Estos conectores no
tienen circuitos eliminadores de oscilaciones, por lo que hay que tener cuidado al usarlos en
circuitos secuenciales.

- Circuitos generadores de sefiales de reloj a 27 Mhz, 50 Mhz, y un conector para un reloj
externo.

- 9 LEDs LEDGO-LEDGS verdes de salida: se encienden a tension alta, se apagan a tension
baja.

- 18 LEDs LEDRO-LEDR17 rojos de salida: se encienden a tension alta, se apagan a tension
baja.

- 8 Displays de 7 segmentos de salida. Los leds de los displays se encienden cuando se
conectan a tension baja y se apagan cuando se conectan a tension alta.

- 1 Display LCD de 16*2 (2 filas de 16 caracteres) de salida.

- Dos conectores externos (o de expansion) de 40 pines, que contienen 72 pines de
entrada/salida + 8 conectores de alimentacion o tierra.

Ademas de estos componentes la tarjeta DE2 tiene muchos otros componentes conectados al
dispositivo programable, y algunos de ellos conectados también al exterior mediante puertos
de entrada y/o salida. Para mas informacion sobre estos componentes ver DE2 UserManual.
Entre estos componentes se encuentran memorias internas (512Kbyte SRAM, 8Mbyte
SDRAM, 4Mbyte FLASH), salida VGA, codificadores de audio y video, puertos RS-232 y
PS2, controladores de USB y Ethernet, etc.

En esta practica se realizaran ejercicios de disefio 16gico utilizando Quartus II de ALTERA

describiendo los circuitos mediante diagramas esquematicos y, principalmente, el lenguaje
VHDL. En el caso de que no se domine la herramienta Quartus II se puede practicar con los
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tutoriales que se encuentran en algunos de los libros recomendados en la bibliografia basica
de la asignatura, o en el CD DE2 (directorio DE2 tutorial), o en la pagina Web de la
asignatura:

- tut_quartus_intro_schem para disefio mediante esquematicos.
- tut_quartus_intro_vhdl para disefio mediante VHDL.

- tut_quartus_simulation_vhdl para simulacion de una descripcion VHDL.

En el CD DE2 también hay otros tutoriales sobre simulacion, analisis temporal, etc.
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El objetivo final del trabajo con Quartus II es generar un fichero de programacion .sof con la
configuracion del dispositivo. Para generar este fichero se deben realizar correctamente los
siguientes pasos:

- Crear un proyecto y describir la operacion del circuito (mediante un diagrama esquematico,
VHDL, Verilog, AHDL) para el dispositivo Cyclone II EP2C35F672C6.

- Asignar las entradas y salidas del circuito a los pines correspondientes del dispositivo
(usando el comando Assignments->Assignment Editor->Pin).

IMPORTANTE: Para evitar problemas que puedan estropear la tarjeta, al asignar las
entradas y salidas del proyecto hay que dejar los pines sin usar del dispositivo como entradas
en alta impedancia. Para ello antes de compilar el dispositivo hay que seleccionar
Assignment->Device, pulsar en el boton Device & Pin Options..., y en la pestafia Unused
Pins en su campo Reserve all unused pins: seleccionar As input tri-stated.
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- Compilar la descripcion del circuito, eliminando los errores de la descripcion. Una
compilacion sin errores genera entre otros resultados el fichero de programacion .sof.

- Simular el circuito para comprobar su funcionamiento antes de cargar el circuito en el
dispositivo. Este paso es muy conveniente, aunque no es absolutamente necesario, a la hora
de producir el circuito final.

Finalmente, para trabajar con la tarjeta DE2 se deben realizar los siguientes pasos:

- Conectar el cable USB al ordenador de trabajo y a la conexion USB Blaster del la tarjeta
DE2 (en la esquina superior-izquierda el conector USB mas a la izquierda).

- Conectar el adaptador de 9V a la red eléctrica (se necesita un conector especial del que se
dispone en el laboratorio), y a la tarjeta DE2 (conector en esquina superior-izquierda).

- Situar el switch RUN/PROG al valor RUN (esta asi por defecto).

- Pulsar el interruptor rojo de encendido.

Al encender la tarjeta se arranca una programacion por defecto del dispositivo que hace que
los LEDS rojos y verdes parpadeen, que los displays de 7 segmentos realicen una cuenta
ciclica de 0 a F, y que el modulo LCD muestre un mensaje de bienvenida. Ademas, si
estuviese conectado un monitor VGA se mostraria una pantalla de bienvenida y si estuviesen
conectados unos altavoces en la salida de audio se oiria un sonido.

Para cargar la configuracion del circuito en la tarjeta se debe cargar el fichero .sof mediante
Quartus II, usando su herramienta de programacion (Tools->Programmer) a través del puerto
USB Blaster [USB-0]. Si no esta seleccionado este puerto por defecto, hay pulsar en
Hardware Setup 'y seleccionarlo en Currently selected hardware:. Ahora, para cargar la
configuracion, hay que seleccionar el fichero .sof, activar la casilla Program/Configure y
pulsar en Start.

A continuacién se indican los ejercicios de manejo de la tarjeta DE2 a realizar en esta
practica. Los ficheros generados en el desarrollo de la practica deben guardarse en la carpeta
de cada grupo en el ordenador en una subcarpeta Pr4, generando dentro de ella subcarpetas
para cada uno de los apartados.

4.1. Utilizacion del panel de control DE2.

El panel de control DE2 permite realizar actuaciones sobre componentes de la tarjeta DE2
(encender/apagar LEDs, cargar valores en los 7-SEG Displays, en la memorias, etc) desde el
ordenador a través del puerto USB. Para utilizar este panel hay que insertar el CD DE2 en el
lector, conectar la tarjeta al ordenador mediante el cable USB, encender la tarjeta DE2 y
ejecutar Quartus II.

El CD DE2 contiene en la carpeta DE2 Control Panel el fichero de programacion
DE2 USB_APILsof. Abrir este fichero en Quartus IT (File->Open) y cargar el contenido en
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la tarjeta (seleccionar el comando Tools->Programmer, la programacion mediante USB
Blaster, activar la casilla Program/Configure y pulsar en Start).

En la carpeta DE2 Control Panel del CD DE2 esta el programa DE2 Control Panel; ejecutar
dicho programa en el ordenador. Este programa controla ciertos componentes de la tarjeta
DE2 a través de USB. Abrir el puerto USB mediante el comando Open->Open USB Port 0.
Seleccionar las pestafias LED & LCD, y PS2 & 7-SEG, activar algunos de los LEDs, fijar
valores en los displays de 7 segmentos y en el médulo LCD. Los valores se cargan en la
tarjeta al pulsar Set. Al pulsar el boton KEYO0 se apagan los LEDs y los displays se fijan al
valor 0.

4.2. Diseiio de un multiplexor de dos entradas (descripcion esquematica).

En este apartado se debe disefiar mediante Quartus II un circuito digital descrito mediante
puertas logicas. Un ejemplo de una descripcion esquematica de un circuito en Quartus 11
puede encontrarse en el fichero tut quartus intro _schem en el CD DE2 (directorio
DE2 tutorial), 6 en la pagina Web de la asignatura.

El circuito a disefar es un multiplexor de dos entradas (10, I1) seleccionadas por la entrada S,
con entrada E de habilitacion, de forma que cuando el circuito esta deshabilitado la salida Z
es 0, y cuando esta habilitado la salida Z toma el valor de la entrada [0 si S es 0 y de I1 si S
es 1. El circuito debe ser cargado en la tarjeta DE2 de forma que las entradas (10, 11, S, E) se
asocien a switches y la salida Z a uno de los LEDs.

Los pasos para la programacion del circuito son:

- Abrir en Quartus II un fichero grafico y editar el circuito mediante esquematicos.
- Crear un proyecto a partir del fichero grafico para el dispositivo Cyclone II
EP2C35F672C6.

IMPORTANTE: Para evitar problemas que puedan estropear la tarjeta, al asignar las
entradas y salidas del proyecto hay que dejar los pines sin usar del dispositivo como entradas
en alta impedancia. Para ello al crear el proyecto, en la seleccion del dispositivo, pulsar en el
boton Device & Pin Options..., y en la pestaia Unused Pins en su campo Reserve all unused

pins: seleccionar As input tri-stated.

- Asignar las entradas y las salidas del circuito a pines (Switches y LED) del dispositivo
programable. La relacion de pines esta en el fichero DE2 UserManual (disponible en el CD
DE2, directorio DE2 user manual, y en la pagina WEB de la asignatura), en los subapartados
correspondientes.

- Compilar la descripcion del circuito, eliminando errores si aparecen, generando el fichero
.sof.

- Simular la operacion del circuito (opcional, pero recomendable).

- Cargar la programacion en la tarjeta DE2 mediante el programador de Quartus II.
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- Verificar la operacion del circuito cambiando la posicion de los switches y observando el
estado encendido/apagado del LED.

4.3. Diseiio de convertidor de cédigos BCD (descripcion VHDL).

En este apartado se debe disefiar mediante Quartus II un circuito digital descrito mediante
lenguaje VHDL. Un ejemplo de una descripcion VHDL de un circuito en Quartus II puede
encontrarse en el fichero tut _quartus_intro VHDL en el CD DE2 (directorio DE2_tutorial), 6
en la pagina Web de la asignatura.

El circuito a disefar es un convertidor entre codigos BCD y debe convertir un cédigo de
entrada X (x3x2x1x0) con pesos (6, 5, 2, -4) en un codigo de salida Z (z3z2z1z0) con pesos
(7, 2, -1, -3). El circuito debe ser cargado en la tarjeta DE2 de forma que las entradas
(x3x2x1x0) se asocien a switches y las salidas (z3z2z1z0) a LEDs.

Los pasos para la programacion del circuito son:

- Abrir en Quartus II un fichero VHDL vy editar la descripcion del circuito mediante este
lenguaje.

- Crear un proyecto a partir de la descripcion VHDL para el dispositivo Cyclone II
EP2C35F672C6.

IMPORTANTE: Para evitar problemas que puedan estropear la tarjeta, al asignar las
entradas y salidas del proyecto hay que dejar los pines sin usar del dispositivo como entradas
en alta impedancia. Para ello al crear el proyecto, en la seleccion del dispositivo, pulsar en el

boton Device & Pin Options..., y en la pestaiia Unused Pins en su campo Reserve all unused
pins: seleccionar As input tri-stated.

- Asignar las entradas y las salidas del circuito a pines (switches y LEDs) del dispositivo
programable. La relacion de pines esta en el fichero DE2 UserManual (disponible en el CD
DE?2, directorio DE2 user manual, y en la pagina WEB de la asignatura), en los subapartados
correspondientes.

- Compilar la descripcion VHDL del circuito, eliminando errores si aparecen, generando el
fichero .sof.

- Simular la operacioén del circuito (opcional, pero recomendable).

- Cargar la programacion en la tarjeta DE2 mediante el programador de Quartus II.

- Verificar la operacion del circuito cambiando la posicion de los switches y observando el
estado encendido/apagado de los LEDs.

4.4. Diseiio de convertidor de cddigo hexadecimal a salida de 7 segmentos (descripcion
VHDL).

En este apartado se debe disefiar mediante Quartus II un circuito digital descrito mediante
lenguaje VHDL. El circuito a disefiar es un convertidor de una entrada X (x3x2x1x0) en
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codigo hexadecimal con valores entre 0-F a su representacion grafica en siete salidas Z
(z0z1227z37472576) correspondientes a los LEDs de un display de 7 segmentos, como se
muestra en la figura. El circuito debe ser cargado en la tarjeta DE2 de forma que las entradas
(x3x2x1x0) se asocien a switches y las salidas (z0z1z2z3z4z5z6) a uno de los displays de 7
segmentos de la tarjeta DE2.
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Los pasos para la programacion del circuito son:

- Abrir en Quartus II un fichero VHDL vy editar la descripcion del circuito mediante este
lenguaje.

- Crear un proyecto a partir de la descripcion VHDL para el dispositivo Cyclone II
EP2C35F672C6.

IMPORTANTE: Para evitar problemas que puedan estropear la tarjeta, al asignar las
entradas y salidas del proyecto hay que dejar los pines sin usar del dispositivo como entradas
en alta impedancia. Para ello al crear el proyecto, en la seleccion del dispositivo, pulsar en el
boton Device & Pin Options..., y en la pestaia Unused Pins en su campo Reserve all unused

pins: seleccionar As input tri-stated.

- Asignar las entradas y las salidas del circuito a pines (switches y display de 7 segmentos)
del dispositivo programable. La relacion de pines estd en el fichero DE2 UserManual
(disponible en el CD DE2, directorio DE2 user manual, y en la pagina WEB de la
asignatura), en los subapartados correspondientes.

- Compilar la descripcion VHDL del circuito, eliminando errores si aparecen, generando el
fichero .sof.

- Simular la operacion del circuito (opcional, pero recomendable).

- Cargar la programacion en la tarjeta DE2 mediante el programador de Quartus II.

- Verificar la operacion del circuito cambiando la posicion de los switches y observando el
valor que aparece en el display de 7 segmentos.

4.5. Diseiio de un contador con salida grafica (descripcion VHDL).

En este apartado se debe disefiar mediante Quartus II un circuito digital que opere como un
contador binario hacia arriba de 4 bits, el valor de cuenta debe mostrarse en un display de 7

- Grupo Dyvci - -7 - - Dept. Electronica y Computadores -



segmentos en el formato utilizado en el apartado anterior (utilizar en los posible la
descripcion VHDL del apartado anterior). El circuito se debe disefiar mediante un circuito
secuencial y debe tener dos entradas Reset y Clk y siete salidas correspondientes al display de
siete segmentos. La sefial de entrada Reset es una sefial asincrona que cuando se activa fija la
cuenta a valor 0, y debe ser asociada a un switch de la tarjeta DE2. Las siete salidas de la
cuenta deben ser asociadas a los LEDs de un display de 7 segmentos de la tarjeta DE2. La
sefial de reloj Clk debe generarse de dos maneras dando lugar a dos descripciones VHDL
distintas:

- 4.5.1. La seal de reloj se conecta a uno de los botones de entrada, de forma que pulsar el
boton produce un flanco negativo en esa sefial, y soltar el boton una vez pulsado un flanco
positivo.

- 4.5.2. La sefial de reloj se genera mediante el reloj interno de 50Mhz de la tarjeta DE2. En
este caso hay que afiadir una tercera entrada EN que activa la cuenta al ser pulsada. EN se
debe generar mediante uno de los botones de la tarjeta DE2.

Los pasos para la programacion de ambos circuitos son:

- Abrir en Quartus II un fichero VHDL y editar la descripcion del circuito mediante este
lenguaje.

- Crear un proyecto a partir de la descripcion VHDL para el dispositivo Cyclone II
EP2C35F672C6.

IMPORTANTE: Para evitar problemas que puedan estropear la tarjeta, al asignar las
entradas y salidas del proyecto hay que dejar los pines sin usar del dispositivo como entradas
en alta impedancia. Para ello al crear el proyecto, en la seleccion del dispositivo, pulsar en el

boton Device & Pin Options..., y en la pestaiia Unused Pins en su campo Reserve all unused
pins: seleccionar As input tri-stated.

- Asignar las entradas y las salidas del circuito a pines (switch para Reset, boton para Clk en
4.5.1 o EN en 4.5.2, reloj de 50 Mhz para Clk en 4.5.2 y display de 7 segmentos) del
dispositivo programable. La relacion de pines esta en el fichero DE2 UserManual
(disponible en el CD DE2, directorio DE2 user manual, y en la pagina WEB de la
asignatura), en los subapartados correspondientes.

- Compilar la descripcion VHDL del circuito, eliminando errores si aparecen, generando el
fichero .sof.

- Simular la operacion del circuito (opcional, pero recomendable).

- Cargar la programacion en la tarjeta DE2 mediante el programador de Quartus II.

- Verificar la operacion del circuito pulsando el boton para ir incrementando el valor de la
cuenta.
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4.6. Diseiio de un circuito sumador (descripcion VHDL).

En este apartado se debe disefiar mediante Quartus II un circuito digital descrito mediante
lenguaje VHDL que opere como un sumador completo de 4 bits (como el sumador 4008
utilizado en la practica 3). El circuito a disefar tiene dos operandos de entrada X (x3x2x1x0)
e Y (y3y2yly0) que son niimeros binarios sin signo de 4 bits y un acarreo de entrada Cin de 1
bit; como salidas tiene una salida de suma S (s3s2s1s0) de 4 bits y una acarreo de salida de 1
bit. El circuito debe ser cargado en la tarjeta DE2 de forma que las entradas y salidas del
circuito estén asociadas a pines de los conectores externos de la tarjeta, para que el circuito
sea verificado desde el analizador l6gico LA4240, que debe suministrar los estimulos de
prueba y mostrar las respuestas obtenidas.

Los pasos para la programacion del circuito son:

- Abrir en Quartus II un fichero VHDL vy editar la descripcion del circuito mediante este
lenguaje.

- Crear un proyecto a partir de la descripcion VHDL para el dispositivo Cyclone II
EP2C35F672C6.

IMPORTANTE: Para evitar problemas que puedan estropear la tarjeta, al asignar las
entradas y salidas del proyecto hay que dejar los pines sin usar del dispositivo como entradas
en alta impedancia. Para ello al crear el proyecto, en la seleccion del dispositivo, pulsar en el

boton Device & Pin Options..., y en la pestaiia Unused Pins en su campo Reserve all unused
pins: seleccionar As input tri-stated.

- Asignar las entradas y las salidas del circuito a pines del dispositivo programable
correspondientes a los conectores externos o de expansion de la tarjeta DE2. La relacion de
pines estd en el fichero DE2 UserManual  (disponible en el CD DE2, directorio
DE2 user manual, y en la pagina WEB de la asignatura), en los subapartados
correspondientes.

- Compilar la descripcion VHDL del circuito, eliminando errores si aparecen, generando el
fichero .sof.

- Simular la operacioén del circuito (opcional, pero recomendable).

- Cargar la programacion en la tarjeta DE2 mediante el programador de Quartus II.

- Verificar la operacion del circuito con el sistema de analisis 16gico LA4240, siguiendo las
pautas seguidas en el apartado 3 de la practica 3 (verificacion del sumador 4008): aplicar los
mismos estimulos en las entradas con los pods del generador de patrones y leer las salidas con
los pods de anélisis logico.

Para facilitar la verificacion del circuito hay que hacer alguna variacion en la programacion
del LA4240 con respecto a la de la practica 3: no se deben leer con el analizador 16gico los
valores de las entradas (es dificil colocar las pinzas en los terminales de los conectores), por
lo que al editar los grupos de canales hay que asociar a los grupos de las entradas a los
canales del generador de patrones. Para realizar el disparo hay que programar una sefial de
inicio en un canal libre del generador de patrones que debe estar a siempre 0 salvo un 1 en la
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direccion en que se comienza a aplicar estimulos al sumador; esta sefial debe ser leida con
una canal libre del analizador 16gico, la marca roja de disparo debe situarse en la direccion de
comienzo de los estimulos, y el palabra de disparo debe formarse con un 1 en el canal del
analizador en el que se lee el pulso de inicio. De esta forma en las entradas se visualizan en
los canales del generador, mientras que las salidas se visualizan en los canales del analizador.
El problema que tiene este sistema es que no es facil detectar errores si se hay algiin problema
en la conexion de las entradas (cables mal puestos o intercambiados). Dependiendo de como
se coloque el disparo las medidas en las salidas pueden aparecer retrasadas o adelantadas una
direccion con respecto a la lectura de las entradas.
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